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Nortel Networks Inc. software license agreement

This Software License Agreement (“License Agreement”) is between you, the end-user (“ Customer”) and Nortel
Networks Corporation and its subsidiaries and affiliates (“Nortel Networks’). PLEASE READ THE FOLLOWING
CAREFULLY. YOU MUST ACCEPT THESE LICENSE TERMS IN ORDER TO DOWNLOAD AND/OR USE THE
SOFTWARE. USE OF THE SOFTWARE CONSTITUTES Y OUR ACCEPTANCE OF THIS LICENSE
AGREEMENT. If you do not accept these terms and conditions, return the Software, unused and in the original shipping
container, within 30 days of purchase to obtain a credit for the full purchase price.

“Software” isowned or licensed by Nortel Networks, its parent or one of its subsidiaries or affiliates, and is copyrighted
and licensed, not sold. Software consists of machine-readable instructions, its components, data, audio-visual content
(such asimages, text, recordings or pictures) and related licensed materials including all whole or partia copies. Nortel
Networks grants you alicense to use the Software only in the country where you acquired the Software. You obtain no
rights other than those granted to you under this License Agreement. You are responsible for the selection of the
Software and for the installation of, use of, and results obtained from the Software.

1. Licensed Use of Software. Nortel Networks grants Customer a nonexclusive license to use a copy of the Software
on only one machine at any onetime or to the extent of the activation or authorized usage level, whichever is applicable.
To the extent Software is furnished for use with designated hardware or Customer furnished equipment (“ CFE”),
Customer is granted a nonexclusive license to use Software only on such hardware or CFE, as applicable. Software
contains trade secrets and Customer agrees to treat Software as confidential information using the same care and
discretion Customer uses with its own similar information that it does not wish to disclose, publish or disseminate.
Customer will ensure that anyone who uses the Software does so only in compliance with the terms of this Agreement.
Customer shall not @) use, copy, modify, transfer or distribute the Software except as expressly authorized; b) reverse
assemble, reverse compile, reverse engineer or otherwise trand ate the Software; c) create derivative works or
modifications unless expressly authorized; or d) sublicense, rent or lease the Software. Licensors of intellectual property
to Nortel Networks are beneficiaries of this provision. Upon termination or breach of the license by Customer or in the
event designated hardware or CFE is no longer in use, Customer will promptly return the Software to Nortel Networks
or certify its destruction. Nortel Networks may audit by remote polling or other reasonable means to determine
Customer’s Software activation or usage levels. |f suppliers of third party software included in Software require Nortel
Networks to include additional or different terms, Customer agrees to abide by such terms provided by Nortel Networks
with respect to such third party software.

2. Warranty. Except as may be otherwise expressly agreed to in writing between Nortel Networks and Custome,
Softwareis provided “AS S’ without any warranties (conditions) of any kind. NORTEL NETWORKS DISCLAIMS
ALL WARRANTIES (CONDITIONS) FOR THE SOFTWARE, EITHER EXPRESS OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE AND ANY WARRANTY OF NON-INFRINGEMENT. Nortel Networksis not obligated to
provide support of any kind for the Software. Some jurisdictions do not allow exclusion of implied warranties, and, in
such event, the above exclusions may not apply.

3. Limitation of Remedies. IN NO EVENT SHALL NORTEL NETWORKSOR ITSAGENTS OR SUPPLIERS
BE LIABLE FOR ANY OF THE FOLLOWING: 8 DAMAGESBASED ON ANY THIRD PARTY CLAIM; b) LOSS
OF, OR DAMAGE TO, CUSTOMER' S RECORDS, FILES OR DATA; OR c) DIRECT, INDIRECT, SPECIAL,
INCIDENTAL, PUNITIVE, OR CONSEQUENTIAL DAMAGES (INCLUDING LOST PROFITS OR SAVINGS),
WHETHER IN CONTRACT, TORT OR OTHERWISE (INCLUDING NEGLIGENCE) ARISING OUT OF YOUR
USE OF THE SOFTWARE, EVEN |IF NORTEL NETWORKS, ITSAGENTS OR SUPPLIERS HAVE BEEN
ADVISED OF THEIR POSSIBILITY. Theforgoing limitations of remedies also apply to any developer and/or supplier
of the Software. Such developer and/or supplier is an intended beneficiary of this Section. Some jurisdictions do not
allow these limitations or exclusions and, in such event, they may not apply.

4. General

a) If Customer isthe United States Government, the following paragraph shall apply: All Nortel Networks Software
available under this License Agreement is commercial computer software and commercial computer software
documentation and, in the event Software is licensed for or on behalf of the United States Government, the respective
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rights to the software and software documentation are governed by Nortel Networks standard commercial licensein
accordance with U.S. Federal Regulations at 48 C.F.R. Sections 12.212 (for non-DoD entities) and 48 C.F.R. 227.7202
(for DoD entities).

b) Customer may terminate the license at any time. Nortel Networks may terminate the license if Customer fails to
comply with the terms and conditions of thislicense. In either event, upon termination, Customer must either return the
Software to Nortel Networks or certify its destruction.

c) Customer isresponsible for payment of any taxes, including personal property taxes, resulting from Customer’s use
of the Software. Customer agreesto comply with all applicable lawsincluding all applicable export and import laws and
regulations.

d) Neither party may bring an action, regardless of form, more than two years after the cause of the action arose.

€) Thetermsand conditions of thisLicense Agreement form the complete and exclusive agreement between Customer
and Nortel Networks.

f)  ThisLicense Agreement is governed by the laws of the country in which Customer acquires the Software. If the
Software is acquired in the United States, then this License Agreement is governed by the laws of the state of New York.
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About this guide

Welcome

This guide describes how to setup and get started using your Nortel Networks
12004 I nternet Telephone.

Topicsinclude:

e Setting up and initializing your i2004 Internet Telephone
e Introducing the i2004 Internet Telephone

e Configuring the i2004 Internet Telephone

e Making calls

e Managing your calls

* Advanced features and services

For abrief overview of how to use the SIP Multimedia PC Client to control your

12004 Internet Telephone, see Appendix A, “Using the SIP Multimedia PC Client
and the 12004 Internet Telephone,” on page 69.

Audience

Thisguideisintended for subscribers of the 2004 Internet Tel ephone services and
features.

i2004 Internet Telephone User Guide
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viii ~ About this guide

Text conventions

This guide uses the following text conventions:

bold text Indicates the 12004 softkey you need to press
Example: Press the Ok softkey.
italic text Indicates new terms, document titles
Example: See the 12004 Internet Telephone User
Guide.
Acronyms

This guide uses the following acronyms:

DHCP Dynamic Host Configuration Protocol
DTMF Dual Tone Multi Frequency

ERC Express Routing Code

ISDN Integrated Services Digital Network
IM Instant M essage

IP Internet Protocol

IPCM Internet Protocol Client Manager
LAN Local Area Network

LCD Liquid Crystal Display

MAC Media Access Control

RTCP Real Time Control Protocol

SIP Session Initiation Protocol

TCP Transmission Control Protocol

URL Universal Resource Locator

VolP Voice over IP

WAN Wide Area Network

NN10042-113
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About this guide ix

Related publications

Other publications related to the 12004 Internet Telephone User Guide:

e 9P Multimedia PC Client User Guide
e 9P Personal Agent User Guide

How to get help

If you purchased a service contract for your Nortel Networks product from a
distributor or authorized reseller, contact the technical support staff for that
distributor or reseller for assistance.

If you purchased a Nortel Networks service program, contact Nortel Networks
Technical Support. To obtain contact information online, go to the

www.hortel networks.com/cgi-bin/comments/comments.cgi URL, then click on
Technical Support.

From the Technical Support page, you can open a Customer Service Request
online or find the telephone number for the nearest Technical Solutions Center.
If you are not connected to the Internet, you can call 1-800-4NORTEL
(1-800-466-7835) to learn the telephone number for the nearest Technical
Solutions Center.

An Express Routing Code (ERC) is available for many Nortel Networks products
and services. When you use an ERC, your call isrouted to atechnical support
person who specializes in supporting that product or service. To locate an ERC for
your product or service, go to the http://www.nortel networks.com/hel p/contact/
erc/index.html URL.

i2004 Internet Telephone User Guide
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Chapter 1

Setting up and initializing your 12004 Internet
Telephone

This section describes how to setup and initialize your 12004 Internet Telephone.

prepared for you to setup and initialize your i2004 Internet Telephone.

Tip: Your system administrator must ensure that your network is

Setup: Before you begin

Before you begin setting up your telephone, check to see that you have the
following components:

12004 Internet Telephone set
telephone handset

telephone handset cord
12004 base

AC adapter

ethernet cable

active LAN connection

Telephone. Refer to the install ation manual packaged with these optional

Tip: Optional hardware buttons can be installed on your i2004 Internet
s

devices for further information.

i2004 Internet Telephone User Guide
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The following picture shows an 12004 Internet Telephone:

6 Line buttons

Set lamp ‘

RTEL
Hﬂnlﬂ'm'nl_-u

%~ Primary line
L B button

ihaiis Display

IIJTIF HIIH

4 softkeys

Handsfree button

with LED
Volume control

Mute Button with LED  Headset button '
with LED Quick buttons

Installing your i2004 Internet Telephone

Warning: Severe damage will occur if this set is plugged into an ISDN
connection. Contact your administrator to ensure that you plug the set into
a10/100-BaseT Ethernet jack.

To connect your i2004 Internet Telephone

1 Connect one end of the handset cord to the handset jack (identified with a
handset icon) on the telephone base, and connect the other end of the handset
cord to the handset.

2 Choose one of the following connections:

NN10042-113
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a For atelephone not sharing a LAN access with a PC:

Connect one end of the Ethernet cable to the Ethernet plug (identified
with a network icon) on the telephone, and the other end to your 10/
100-BaseT Ethernet jack.

b For atelephone sharing a LAN access with a PC:

Complete step aand connect one end of a second Ethernet cable to the PC
Ethernet port on the back of the telephone and the other end to the
computer’s Ethernet port.

Plug the AC adapter plug into the base of the telephone.
Plug the AC adapter into the nearest electrical outlet.

Connect the base to the telephone set. To do thisyou must first ensure that
your power cable and handset cable are properly fitted into the provided slots.

6 Once the power cable and handset cable are secured tightly in place and flush
with the bottom of the phone set, take the base and hinge it into the plastic
dots at the front of the phone set. Then, press the back of the base into the
back of the telephone.

7 Tolock the base in place, depressthe light gray button at the back of the
phone set while carefully pressing the base into place. Release the button to
lock the base onceitisin place.

your desktop, re-examine the phone's cables to ensure the cables are not

Tip: If you have trouble locking the base, or if the phone waobbles on
obstructing the base.

i2004 Internet Telephone User Guide
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Initializing your i2004 Internet Telephone

require apartia or total initialization. Refer to “Initializing options’ on

Tip: Your i2004 Internet Telephone may be pre-configured or may
page 5.

When you power up the i2004 Internet Telephone for the first time, you will see
the introduction screen with a flashing Nortel Networks display as shown in the
following picture:

06/06 9:31 am

Nortel Networks

L

NN10042-113
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Table 1 Initializing options

When you power up your i2004 Internet
Telephone ...

Then ....

if the display shows that the server is
unreachable and continuously resets

01/01 12:00 am

Server unreachable
Restarting . . .

go to “Setting DHCP parameters” on
page 77 and follow the steps in the order
they appear.

if the telephone successfully connects to the
server and the display prompts you to enter
an activation key

Activate 06/06 9:31 am

Enter Activation Key
And Press Ok
>

Ok Alpha

go to “Step 1: Enter an activation key” on
page 6.

i2004 Internet Telephone User Guide
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Table 1 Initializing options

When you power up your i2004 Internet
Telephone ...

Then ....

if the telephone successfully connects to the
server and the display prompts you for your
login id
User Login 06/06 9:31 am
Enter ID and Press

Login:
> Tom

Login NoAlpha

the i2004 has been provisioned but a user
has not been assigned. Go to “Step 2:
Logging in to your i2004 Internet
Telephone” on page 7.

if the telephone successfully connects to the
server and the idle display screen appears

Tom =
OnHook 06/06 9:31 am
Welcome
View Servcs DND Config

you are ready to use your telephone. Go
to Chapter 2, “Introducing the i2004
Internet Telephone,” on page 13.

the correct information to use during the initialization procedure.

Tip: You may need to contact your system administrator to determine
';

Step 1: Enter an activation key

When the 12004 successfully connectsto the server, the Enter Activation Key

screen appears.

automatically retry every two minutes. After several attempts, if your

Tip: If your i2004 Internet Telephone cannot locate the server, it will
'Q

telephone set does not locate the server, contact your system

administrator for assistance.

NN10042-113
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Figure 1 Enter Activation Key screen

Activate 06/06 9:31 am

Enter Activation Key
And Press Ok
>

Ok Alpha

Tip: Your system administrator will provide you with an activation key.
'Q

Enter the activation key and press the Ok softkey, the following screen displays:

Figure 2 Unprovisioned Device - Contacting Database Display

Activate 06/06 9:31 am

Provisioning . . .

Ok Alpha

Once the i2004 Internet Telephone is successfully provisioned then you may see
an idle display that indicates you are ready to use the phone or, you may be
prompted to log in.

Step 2: Logging in to your i2004 Internet Telephone

The deviceisready for login, and the newly provisioned device idle screen
displays. At the prompt, enter your username and password supplied by your
system administrator.

i2004 Internet Telephone User Guide
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Figure 3 shows user "tom" logging in.

Tip: When typing in your user name, you only need to typein the "user
portion of the name, not the @domain portion.
5

Figure 3 Newly provisioned device login display

User Login 06/06 9:31 am

Enter ID and Press
Login:
> Tom

Login NoAlpha

Figure 4 shows user "tom" entering his password of "guest". Non-alphanumeric
digits are entered by first pressing the NoAlpha softkey.

Figure 4 Requesting User Password

Tom 06/06 9:31 am
Enter Password and Press
Login:
>guest
Login NoAlpha

After typing your password, the following screen appears.

NN10042-113
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Figure 5 Entering Logon Time

Tom 06/06 9:31 am

Enter Logon Time:
1

>[hours]

Login UseProv Days Cancel

Enter the amount of time you want to be logged in or pressthe UseProv softkey to
use the network provisioned values. Then, pressthe L ogin softkey.

Tip: If you specify aLogon Time (for example, 1 hour) then the
telephone will automatically log off after that time. If you choose
s UseProv then you will be automatically re-registered and remain logged
in until you manually log off.

Note: To changethe network provisioned valuesfor the UseProv softkey
=»| seethe P Personal Agent User Guide.

If the 12004 has been provisioned into the database and a user has been assigned,
then the OnHook screen displays (Figure 6).

i2004 Internet Telephone User Guide
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Figure 6 Idle Screen

=
s

OnHook 06/06 9:31 am

Welcome

View Servcs

LL/L/L/

Tip: Theidle screen text (for example, "Welcome") can be changed and
s

may vary depending on what has been provisioned. Refer to “ Setting the

idle display of the 2004 Internet Telephone” on page 30 for more
information.

To reset your i2004 Internet Telephone

Use the Reset Phone option in the Config menu (see “ Resetting your 12004
Internet Telephone”’ on page 33) or unplug your telephone.

NN10042-113
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To upgrade firmware

Tip: If thereisanewer firmware load for your i2004 Internet Telephone
then you need to upgrade.
J

When the display prompts you to upgrade your firmware

[ 1]
Tom T

Firmware 06/06 9:31 am

Install latest firmware?
From: 1234B56
To: 1234B57

Now Later

e Pressthe Now softkey to upgrade, or pressthe Later softkey and manually
start the update at a later time through the Configuration menu (see
“Displaying 12004 information” on page 32).

Note: If you pressthe Later softkey then the system will periodically
prompt you to upgrade.

i2004 Internet Telephone User Guide
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Chapter 2

Introducing the 12004 Internet Telephone

This section describes: the features and services available on your 12004 Internet
Telephone and some basic functions to get you started using your phone.

Your i2004 Internet Telephone: features and services

Your i2004 Internet Telephone is adevicethat is as familiar and easy to use as
your traditional telephone, yet capitalizes on al the new capabilities available
from your internet connection. Here are some of the features and services:

Hardware features

integrated 3 port switch
high-quality Voice over IP (VolP) sound
integrated headset jack

local generation of call aerting, call progress, and dial tones (as well as
support for out-of-band DTMF signaling) to conserve valuable LAN/
WAN bandwidth

dedicated hold, release, handsfree, headset, and mute buttons
user-selectable ringer, speaker, handset, and headset volume

large multi-field LCD display for calling party number, and subject
display (between SIP clients)

wideband-compatible speakerphone (150 Hz to 7 kHz) with acoustic echo
cancellation

hearing-aid compatible

Software features

call forward, ignore, decline, and transfer
conference, call waiting, and call hold
automatic registration on activation of the device

i2004 Internet Telephone User Guide
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— multiple user logon
— inbox

— outbox

— address book

— list of Buddies

Your i2004 Internet Telephone aso provides features not available on traditional
phone systems including:

instant messages—send, receive and reply to instant messages on your i2004
Internet Telephone.

stock query—abtain stock quotes directly on your i2004 Internet Telephone
display.

Note: Thisfeature may not be activated for your system. Contact your

=»| system administrator for more information.

bulletins—receive messages from your service provider, such as news of an
upcoming system upgrade, directly on the display screen of your 12004
Internet Telephone.

QoS—view quality of service information for the media stream of the call on
your 12004 Internet Telephone. Your service provider can use thisinformation
to analyze network performance.

NN10042-113
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Some useful terms you should know

The i2004 Internet Telephone may look like aregular telephone but there are
some important differences that you need to keep in mind.

Multiple user logon

Your i2004 Internet Telephone can support up to 6 lines. That means that 6
different people can log on to a single i2004 Internet Tel ephone to receive and
place calls. Thefirst person who logs on to the telephone has the primary line.
You can also be logged on to several different i2004 Internet Telephones at the
sametime. If you have ajob function that requires you to move around to different
locations then you can always be sure that your calls will reach you.

Some menu options allow you to configure or view parameters that are specific to
aline. If there are multiple users logged on to the telephone then you will be
prompted to select your line button.

What is an address?

When you enter an addressto call someone, that can mean entering; a telephone
number or a SIP address. A SIP addressis a unique identifier of users on the IP
network. It has the same format as an email address, for example, jdoe@Ilabl.org,
but it is not an email address. The characters before the @ sign represent the
username, in our example, jdoe. The characters after the @ sign represent the
domain name of the server, in our example, labl.org. If you are located in the
same domain as the user you are calling then you do not need to enter the domain
name part of their SIP address (@labl.org).

The network can track where you are and route your calls when you log into any
12004 Internet Telephone with your SIP address. Using SIP addresses allows you
to take advantage of the other powerful features such as Presence.

In order to make it easier to place calls, you can store addresses (S|P addresses or
telephone numbers) in an address book.

i2004 Internet Telephone User Guide
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Address book

Your personal network-based address book is a key tool for managing addresses.
You can save your addresses for quick call access aswell as organize addresses
into groups.

Inbox| S

Your i2004 Internet Telephone keepstrack of al the calls you receive which you
can view by pressing the inbox button. Using the softkeys you can view alist of
al the people who have called you or just the calls that you have missed. With the
press of a softkey you can dial entries from your inbox.

Outbox [NEEY

Your i2004 Internet Telephone keeps track of all the calls you have made which
you can view by pressing the outbox button. With the press of a softkey you can
redial entries from your outbox.

Buddies

Within your network-based address book you can designate entries as buddies. If
you have entered the SIP address of the person then you can see their online
presence status.

Presence

Presenceis afeature that alows you to see the online status of other users on the
network and also away to aert othersto your status. Through the View menu you
can change your presence statusto let other users know if you are online or away
from your desk. Through the View menu you can check the presence of the users
you have designated as buddies.
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Getting to know the 12004

12004 buttons

Your 12004 Internet Telephone includes buttons that provide instant access to
features of the set. The following picture shows the buttons available on your
12004 I nternet Telephone:

Hold button Set lamp

Goodbye button

e, L L Line buttons

- Primary line
gt 88 button
s Display

blllﬂ

4 softkeys

Handsfree button . Headset button
with LED Mute button with LED  ith | ED Quick buttons

Volume control bar
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Using the i2004 quick buttons

Thei2004 quick buttons provide pre-programmed service access with atouch of a
button. The quick buttons are located along the bottom of your 12004 phone, from
middle to far right, as shown in the following picture:

Quit Inbox toggle
[ T Fea
Address book Inbox Outbox Quick Switch
Services Server

During certain operations (such as receiving an incoming call) the quick buttons
will remain disabled. In some situations (such as programming a Forward to
Destination), the address book and outbox quick buttons may be used to select
and/or switch between the lists as applicable. Table 2 lists the 12004 Internet
Telephone quick buttons and functions.
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Table 2 12004 quick buttons

Pressing this quick
button... Activates this function and softkeys...

Address book Access to a network-based address book. Select

e Call - to place a call to the highlighted entry in the list
¢ Add - to add an entry in the list

* Modify - to edit or delete the highlighted entry

e Ok - toreturn to the idle display

If there are multiple users on the phone, you will first be presented with a list of
address books and the following softkeys

* Select - to display the missed calls for the highlighted Inbox
¢ Cancel - to return to the idle display
For more information see “Managing your address book” on page 57.

Inbox Displays a log of calls received. Select

e Call - to place a call to the highlighted entry in the list

« All/Missed - toggles between the list of all calls and those you missed
« Delete - to remove the highlighted entry from the list

e Ok - to return to the previous screen (list of Inboxes or idle display)

If there are multiple users on the phone, you will first be presented with a list of
Inboxes and the following softkeys

« Select - to display the missed calls for the highlighted Inbox
¢ Cancel - to return to the idle display
For more information see “Using the inbox options” on page 55.

:

Outbox Displays a log of the most recent calls you made. Choose
e Call - to dial the highlighted entry

» Delete - to remove an entry

¢ Ok - toreturn to the previous menu

If there are multiple users on the phone, you will first be presented with a list of
Outboxes and the following softkeys

« Select - to display the missed calls for the highlighted Inbox
¢ Cancel - to return to the idle display
For more information see “Managing your outbox” on page 58.

[

Quick Services Access to Presence, Stock Query, and Send IM. Choose
« Select - to select the highlighted entry
¢ Cancel - to return to the idle display

For more information about these features see “Advanced features and services”
on page 61.

.
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Table 2 12004 quick buttons

Pressing this quick
button... Activates this function and softkeys...

Switch Server Allows you to select an alternate server. A display prompts "Use Alternate
Server?" and displays the IP and Port of the alternate server. Select

¢ Ok - to have your i2004 Internet Telephone attempt to connect to the
alternate server listed in the display

e Cancel - to return to the idle display

Quit Allows you to cancel a feature or function.
Inbox lists toggle Allows you to toggle between the Inbox lists of all calls or just the list of call that
you missed.

E==D
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The 12004 display

The i2004 Internet Telephone display is organized as follows:

line button
user label

line
buttons

line
buttons

| primary
line

line status
icon

status OnHook 06/06 9:31 am

main display

> time and
Welcome date

softkey
-— labels

T

softkeys

e the main display, when idle, shows the day and time, the online status of the
primary line user, as well as any bulletins sent by your service provider. The
display changes to show call activity (such as, who is calling), feature
activation and menu options.

« thelineinformation area of the display shows:

— who islogged on to the telephone and what line they are assigned. The
first person to log on is assigned the primary line.

— line statusicons that change according to call activity. For more
information about icons see “ Recognizing common i2004 Internet
Telephone icons.” on page 24.

» the softkey area of the display shows the labels for the corresponding
telephone buttons below. The softkey labels will change according to the
telephone activity. From the idle display you can access the View, Services
and Config menus aswell as activate the DND (Do not Disturb) feature.
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Entering alphanumeric characters

You can make a call by dialing atelephone number or by dialing a person’'s
aphanumeric address (for example, jdoe@domain.com). Alphanumeric dialing
refers to the spelling of names or words by dialing al phabetic characters
co-located with the numbers on the numeric dialpad of your 12004 Internet
Telephone.

For example, the 6 button on your numeric dial pad represents the letters "m,""n,"
and "0". You can cycle through the letters (and finally the actual number) by
repeatedly pressing the number button. Names or words that have two adjacent
letters that require the same button, such asin the name "nortel”, are entered by
entering the first character, briefly pausing, and entering the next | etter.

To practice using alphanumeric dialing, follow the stepsin Table 3 to spell the
word “nortel".

Table 3 Alphanumeric dialing exercise

Step Action Result

1. Go off-hook, press the Alpha The first time the 6 button is pressed, "m"
softkey, and press the 6 (MNO) appears on the display. The second time
button twice on the dial pad. the 6 button is pressed the letter "n"

appears on the display.

2. Pause for one second and press | The letter “0” appears on the display.
the 6 button three times.

3. Press the 7 button twice. The letter "r" appears on the display.

4. Press the 8 button. The letter "t" appears on the display.

5. Press the 3 button twice. The letter "e" appears on the display.

6. Press the 5 button three times. The letter "I" appears on the display.

Note: Your i2004 Internet Telephone may already default to
=*| a phanumeric dialing. If you see the NoAlph softkey then you are already
in alphanumeric dialing mode.
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Tip: To enter an uppercase letter, press the up navigation button
following the entered letter. To change to lowercase press the down
s navigation button following the entered letter. The back navigation

button erases the last character. To enter a space, press the right
navigation button.

In alphanumeric dialing, the 1 button represents the following characters:

Table 4 Symbols

Character Name

@ at
period

- dash

_ underscore

& ampersand
apostrophe

n carat

? guestion mark

! exclamation point

( left parenthesis

) right parenthesis
comma

1 numeral 1

Note: To enable or disable the Alphanumeric dialing option see “ Setting
=>| preferences’ on page 28.

Helpful hints

e inanumbered menu list pressthe dial pad number that corresponds to theitem
onthelist to highlight it

« usethenavigation buttonsto scroll vertically and horizontally through display
information
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Recognizing common i2004 Internet Telephone icons.

» usethe * dialpad button to return to the beginning of alist and the # button to

gototheend of alist

« tocapitalize aletter, first enter the letter using the dialpad and the press the up

navigation button to apply capitalization

The i2004 Internet Telephone displays various icons to indicate call and feature
status. The following table presents some of the more common iconsthat you will
see on the display.

Table 5 2004 Internet Telephone icons

Icon

Meaning

telephone line is idle

Y
o

shows when a call feature is activated (for example,
call forward)

when blinking, indicates a problem with the network

(try to log in again or contact your Network
Administrator)

)

ringing call

LA

if this icon displays beside a line button the
telephone is off-hook

if this icon displays in the Inbox then it indicates a call
that you answered

Lo

another active call

ik

active call has been put on Hold
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Table 5 2004 Internet Telephone icons

Icon Meaning

message waiting

instant message

d
E :l::l missed call
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Chapter 3

Configuring the i2004 Internet Telephone

This section describes the settings that you can customize on your 12004 Internet
Telephone. The Configuration menu of the 12004 Internet Telephone includes the
following options:

00 N O o M WN PP

Contrast Setting
Preferences

Idle Display
Location

Time Preferences
Display Version
Reset Phone
Switch Controller

Tip: For quick selection, press the number on the dialpad that
corresponds to the menu item. Use the up and down navigation buttons
to scroll through the Configuration menu list. The* button takes you to
the beginning of alist and the # button takes you to the end of alist.

Note: Some menu options allow you to configure or view parameters
that are specific to aline. If there are multiple users logged on to the
telephone then you are prompted to select your line button.
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Adjusting the contrast settings

To set how light or dark the characters appear on your LCD display

1 Pressthe Config softkey.

2 Highlight the Contrast Setting option and press the Select softkey.

3 Usethe navigation left and right buttons to make the display lighter or darker.
4

Press the Ok softkey when you are satisfied with the contrast, or the Cancel
softkey to cancel any changes to the display.

Setting preferences

The preferences sub-menu offers the following options:

» AlphaDialing - set the default dialing mode
« IM Display - block instant messages from appearing on the display
« Ignore Action - choose a setting for the Ignore softkey

Setting alpha-numeric dialing

You can set the tel ephone dialpad to default to alphanumeric dialing or to dia only
numbers. To change the alphanumeric dialing default

1 Pressthe Config softkey.

2 Highlight the Preferences option and press the Select softkey.

3 Highlight the Alpha Dialing option and press the Change softkey.

4

Press the Ok softkey to change the Alphanumeric dialing option or pressthe
Cancel softkey to exit.

Note: For more information about using alphanumeric dialing see
ndE Entering alphanumeric characters’ on page 22.
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Setting IM display

You can choose to block all incoming instant messages so that the text does not
appear on the telephone display. The default setting is ON. To change the IM

display setting
Press the Config softkey.
Highlight the Preferences option and press the Select softkey.

1
2
3 Highlight the IM Display option and press the Change softkey.
4

Press the Ok softkey to change the IM Display option or press the Cancel
softkey to exit.

Setting Ignore action

You can set the actions of the Ignore softkey. The Local setting stops an incoming
call from ringing on your 12004 Internet Telephone, any other devices defined in
your ring list continue to ring for the duration of the ring list before advancing to
the next ring list. The Network setting stops the incoming call from ringing on all
devices defined in your ring list and forwards the call to the next ring list (if
defined). For example, you may set up your ring list sequence to go to your
voicemail account.

Tip: For more information about creating aring list refer to the SP
Personal Agent User Guide.
s

Press the Config softkey.
Highlight the Preferences option and press the Select softkey.
Highlight the Ignore Action option and press the Change softkey.

A W N P

Press the Ok softkey to change the Ignore Action option or press the Cancel
softkey to exit.
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Setting the idle display of the i2004 Internet Telephone

You can customize atext label to display when your telephoneisidle.To set the
idle display of the telephone

1 Pressthe Config softkey.

2 Highlight the I dle Display option and press the Select softkey. The display
shows Set |dle Display: and atext label.

3 Usetheleft navigation button to erase the current text and enter the text you
want to display on your telephone. (For example, John’'s phone.)

4 Pressthe Ok softkey. The new text label displays on the screen when the
telephoneisidle.

Specifying the location

You can enter atext description of where the telephone physically resides (for
example, 1st Floor Lobby).

To change the system default information for the location of your telephone

1 Pressthe Config softkey.

2 Highlight the L ocation option and press the Select softkey. The display
shows the current location description.

3 Usetheleft navigation button to erase the current text and enter the text you
want to display on your telephone. (For example, Meeting Room.)

4 Pressthe Ok softkey.
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Setting time preferences

You can choose how the date and time displays on your telephone screen and set
your time zone.

Time Prefs 06/06 9:31 am

Date Format: DD/MM
Timezone: Central Standa
Time Format: 12-hour

DateFm TmZone TimeFm Ok

Tip: Usethe left and right navigation buttons to horizontally scroll the
ot
J

Changing the date format
To choose whether the date format displays as month/day or day/month

1 Pressthe Config softkey.

2 Highlight the Time Preferences option and press the Select softkey. The
screen displays the current Time Preferences settings.

Pressthe DateFm softkey. A list of date format choices appears on the screen.
Highlight the date format you want and press the Select softkey.

Press Ok to exit or choose another Time Preferences option.

Changing the time zone

To specify your time zone

1 Pressthe Config softkey.

2 Highlight the Time Preferences option and press the Select softkey. The
screen displays the current Time Preferences settings.
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3 Pressthe TmZone softkey. A list of time zone choices appears on the screen.

4 Highlight the time zone format you want and press the Select softkey.

5 Press Ok to exit or choose another Time Preferences option.

time zone descriptions.

Tip: Usethe left and right navigation buttons to horizontally scroll the
S

Changing the time format

To specify how the clock will display time

1
2

Press the Config softkey.

Highlight the Time Prefer ences option and press the Select softkey. The
screen displays the current Time Preferences settings.

Press the TimeFm softkey. A list of time format choices appears on the
screen.

Highlight the time format you want and press Select.

Press Ok to exit or choose another Time Preferences option.

Displaying i2004 information

To view technical information about the telephone and system

1
2

Press the Config softkey.

Highlight the Display Version option and press the Select softkey. The screen
displays; the system release, build and date, IPCM | P address and port,
firmware version, MAC address, |P Address of the 2004 and Termina ID,
Domain, Location. Use the navigation buttons to scroll through the
information on the screen.

Press the FirmW softkey for a prompt to upgrade the firmware to the latest
availableload, or Cancel to return to the idle display.
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Resetting your i2004 Internet Telephone

To reset your phone to reconnect to the server

1 Pressthe Config softkey.
Highlight the Reset Phone option and press the Select softkey.

3 Pressthe Ok softkey to confirm the reset, or cancel to return to the idle
display.

Switching the server control

If the connection to your server drops, your 12004 Internet Telephone will
automatically switch to the secondary server. You can also manually switch to the
secondary server.

To manually change the proxy server that controls your i2004 Internet Telephone

1 Pressthe Config softkey.
Highlight the Switch Controller option and press the Select softkey.

3 Atthedisplay prompt, confirm the IP address and port number of the alternate
server.

4 Pressthe Ok softkey. The control of the phone switches to the new server.

Note: Asashortcut you can use the Quick button to
=»| change servers. E
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Chapter 4
Making calls

This section describes the various ways that you can place and receive calls on
your 12004 Internet Telephone.

Getting started: i2004 functions

The i2004 Internet Telephone functions table lists the steps to follow for some of
the functions you will use on an everyday basis.

Table 6 2004 Internet Telephone functions

To...

Do this...

Place a call

1. Pick up your handset or press the Handsfree button
to go off hook on the primary line (the green line
button).

2. Dial a phone number or enter an alphanumeric
address. See“Entering an address” on page 38.

3. Either wait briefly for the phone to place the call
automatically, or you can press the Send softkey.

4. Hang up the handset or press the
button to disconnect from the call.
To place a call to an entry in your inbox, outbox, address

book or list of buddies see Chapter 5, “Managing your
calls,” on page 51.
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Table 6 2004 Internet Telephone functions

To...

Do this...

Place a
conference call

1.

After initiating or receiving a call, press the NewCall
softkey to invite an additional party to the
conversation.

Dial a phone number or enter an alphanumeric
address. You will hear the second number ring.

Wait for an answer, then press the Join softkey.

Hang up the handset or press the Goodbye softkey
to disconnect from the conference.

Check a stock
guote

Select the Servcs softkey.

Use the navigation buttons to highlight and select the
Stock Query feature from the display area.

Use the alphanumeric keypad to enter the symbol in
the display area of the stock you wish to query. If you
make a mistake, re-enter the symbol and the
previous entry is deleted.

Select the Submit softkey to initiate your query.
Once the query is complete, the quote appears on
the display.

Softkey dialing options

When you go off-hook to make acall theidle display changes:

Tom Ca

06/06 9:31 am

Redial Alpha Subject
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Press

e VMail to dial your voice mailbox

* Redial to dial the last number you called

e Alpha/NoAlph to activate alphanumeric diapad characters
e Subject to select acall subject to add to you call

Placing a call

You can make calls with your i2004 Internet Telephone in any of the following
ways:

To make a call with

the... Do this...

Handsfree button Press the Handsfree button to go off-hook on the
primary line (the green line button) and produce a
dial tone.

Line button Press any available line button to produce a dial

tone. An available line is one that has a user name
listed next to it.

Handset Pick up the handset.

Headset button Press this button to go off-hook on the primary line
(the green line button) and produce a dial tone.
z,

~

' Tip: Pressthe @ button to disconnect from the call at any
time.
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Entering an address

To make acall you can dial anumber (numeric address such as, 555-1212) or an
alphanumeric SIP address (jdoe@domain.com).

To enter an address using the dialpad
1 Dial the number using the dialpad. When dialing, the left navigation button

acts as a backspace button.

2 Whenyou finish dialing the number, the phone automatically placesthe cal if
nothing has been entered for a short time. You can expedite the dialing by
pressing the Send softkey.

To enter an address using a phanumeric dialing

1 Once off-hook, pressthe Alpha softkey to begin dialing.

2 After entering the name or word, press the Send softkey, or wait for the phone
to place the call.

Note: For more information about alphanumeric dialing see “ Entering
nd aphanumeric characters’ on page 22 and “ Setting preferences’ on
page 28. If the NoAlph softkey appears on your display then
alphanumeric dialing is already enabled.

Adding subjects to a call

You can send aline of text to the person you are calling to let them know why you
are calling. The subject text will appear on the display of the person you are
calling. This procedure assumes that alist of call subjects has already been
defined. For information on how to create or change subject text see “Adding call
subjects’ on page 53.

To add a (pre-defined) subject to an outgoing call

1 Whilemaking acall, press the Subject softkey and use the navigation buttons
to highlight the desired subject.
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2 Pressthe Select softkey. The subject text will appear on the screen of the
person you are calling (if their device supports this feature).

customize your list of subjects. For more information refer to the SP

Tip: If you have accessto the SIP Persona Agent then you can quickly
Personal Agent User Guide.

Answering an incoming call

When an incoming call is ringing the following options are available:

Tom )]
Ln1 Tom 06/06 9:31 am
&' From: Connie
(cellis)
Answer Redrct Decline Ignore

Press:

e Answer to answer the call with handsfree or pick up the handset

* Redrct to send the call to another destination

e Declineto stop the call from ringing (cancel)

* Ignoreto stop the call from ringing and handleit through aring list

See “Incoming call options’ on page 46 for more information.

Note: For information on how to use set up ring lists refer to the SIP
=»| Personal Agent User Guide.
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After you have answered a call

The following softkey options are available to you after answering a call.

Table 7 Softkey options for answered calls

Softkey

Description

Trnsfr

Transfers the call to another party

Audio

Displays details about the current codec
setting

NewCall

Initiates new outgoing calls

QoS

Displays quality of service information
for the media stream of the call

Note: Your Service Provider uses these
metrics to monitor system performance.

Active call actions

After you have answered a call, the following options are available:

Press:

Tom Ca
Ln1 Tom 06/06 9:31 am
L& From: Connie
(cellis)
Trnsfr Audio NewcCall QoS

e Transfer to send this call to another person

« Audio to view and change audio setting parameters

* NewCall to put the active call on hold and call ancther person
e QoSto view the quality of service for the current call
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Receiving a second call

If you are on an active call and someone elsetriesto call you on the sameline, the
the i2004 Internet Telephone will alert you with an audible beep and the ringing
call information will appear on the display. For example:

o A WO DN B

While mjane and jdoe are talking, jdoe receives an incoming call from csmith.
An audible beep aerts jdoe of theincoming call from csmith.

The information about the call with mjane no longer appears on the screen.
Thecaller ID for csmith displays and aringing icon appears next to csmith.

The softkeys along the bottom of the screen also change. The softkeys apply
to csmith’scall.

jdoe can use the softkeys to Answer, Rdirct, Decline, or I gnorethe call from
csmith while continuing to talk to mjane.

Answering a second call

When answering a second call

1

To answer the incoming call with csmith, jdoe presses the line button next to
jdo€’'s name, or presses the Answer softkey, while csmith’scaller ID
information is highlighted.

Thefirst call (between mjane and jdoe) is placed on hold.
The new call between csmith and jdoe becomes active.

When the second call is answered, the display changes to reflect these new
states. The phone icons on the screen indicate the state of the calls. The
softkeys change and apply to the highlighted call, which is now csmith.
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jdoe Ca
jdoe 06/06 9:31 am
wrdk From: mjane
C& From: csmith
Transfr Audio NewcCall Join

Switching between active calls on the same line
To switch between calls that are on the same line

1 Usethe navigation buttons to highlight the inactive cal.

2 Pressthe line button associated with the call or press the Switch softkey to
switch calls.

A ——
jdoe (o §
jdoe 06/06 9:31 am
wrdk From: mjane
L& From: csmith
Switch Ris NewCall Join

The following example describes how to switch between calls on the sameline:
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jdoe uses the navigation buttons to highlight the inactive call with mjane.

jdoe presses the Switch softkey or the line button next to jdoe's name on the
screen. The call between csmith and jdoe is put on hold.

Once again, the call between mjane and jdoe becomes active, and mjane’sline
remains highlighted. The phone icons on the screen indicate the state of both
calls.

When the active call is switched, the display changes. The hold icon appears
beside the call on hold and the off-hook icon appears beside the active call.

Highlighting csmith’s call and pressing the Switch softkey will place mjane
on hold and switch the call back to csmith.

cdls.

Tip: Switching between calls works for both incoming and outgoing
s

Ending a call @

To end an active call, pressthe Goodbye button or put the handset on the receiver.

In the following example, jdoe is conversing with mjane. mjane's call is
highlighted. To end this active call

1

jdoe presses the Goodbye button or puts the handset on the receiver. The call
is released between jdoe and mjane. The call between jdoe and csmith is left
on hold. The information about the call between jdoe and csmith is displayed
using the full screen. jdoe presses the Hold softkey to resume conversation
with csmith.
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Placing a conference call

The

12004 Internet Telephone allows you to connect calls together to form a

conference.

Whi
call.

leon acall, you can initiate a conference call to connect new parties to the

To place a conference call using the NewCall softkey

1

4

Press the NewCall softkey. Your current call is automatically put on hold.
Enter the new address.

Press the Send softkey. The new address begins to ring. Once the new party
answers the call, the display changes. You can speak to the newly called party
and the original called party is still on hold.

When the party answers press the Join softkey to connect the calls.

To place a conference call to entriesin your inbox, outbox or address book. While

onacall

1 Pressthe NewCall softkey. Your current call is automatically put on hold.

2 Pressan inbox, outbox or address book quick button.

3 Highlight an entry.

4 Pressthe Select softkey. The new address begins to ring. Once the new party

answers the call, the display changes. You can speak to the newly called party
and the original called party is still on hold.

To complete the conference call, press the Join softkey.

up and the remaining callers on a conference call will still be connected.

Tip: Any party, including the originator of the conference call, may hang
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Placing a call on hold @

To place acall on hold

1

Press the Hold button to place the other party on hold. The hold icon beside
the line button flashes.

Press the Hold button a second time or press the line button associated with
the call on hold to resume the conversation.

your display flashes.

Tip: If someone else puts you on hold (remote hold) the hold icon on

Transferring a call

You can transfer a call without speaking to the person you are transferring to
(blind transfer) or you can consult with them prior to completely the transfer.

Call transfer

While on acall, you can transfer a call to another location without waiting for the
new party to answer. The originating or terminating party can initiate the transfer,
but is no longer involved in the call upon completing the transfer.

To transfer acal

1
2

Pressthe Trnsfr softkey.

Enter the address where you want to transfer this call. Or, press the quick
buttons to access and select an entry from the inbox, outbox or address book.

Press the Trnsfr softkey. The display prompts you to select whether or not
you want to consult with the called party.

Press the No softkey to complete the transfer without consulting with the
party you are calling. The original called party is put on hold. The display
confirmsif the transfer is complete or fails.
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5

Pressthe Ok softkey to returnto an idle display or, if the transfer failed, press

the line key to reconnect the call.

Call transfer with consult

While on acall, you can call another address, speak with the person at the new
address, and then transfer the original call to the new address. You must be the
cdler in order to initiate atransfer with consult.

To transfer with consult

1
2

Press the Trnsfr softkey.

Enter the address where you want to transfer this call. Or, press the quick
buttons to access and select an entry from the inbox, outbox or address book.

Press the Trnsfr softkey. The display prompts you to select whether or not
you want to consult with the called party.

Press the Yes softkey to consult with the party you are calling. The original
called party is put on hold. The call to the new address rings.

Consult with the party you wish to transfer the first call too. Pressthe Trnsfr
softkey to complete the transfer or Cancel to disconnect and return to the
original call. The display confirmsif the transfer is complete or fails.

Pressthe Ok softkey to returnto an idle display or, if the transfer failed, press
the line key to reconnect the original call.

Incoming call options

The following softkey options are available for incoming ringing cals.

Table 8 Softkey options for ringing calls

Softkey Description

Answer Answers the call.

Redrct Allows you to redirect the call to
another address.
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Table 8 Softkey options for ringing calls

Softkey

Description

Decline

Stops the call from ringing (does not
advance to the next ring list). The call is
cancelled and a message is sent to the

caller.

Note: Decline stops a call from ringing
on all devices defined in your ring list.

Ignore

Stops the call from ringing on your
i2004 Internet Telephone (call handling
depends on the feature settings). The
call is then handled by your ring list.

For more information about Ignore
feature settings see “Setting Ignore
action” on page 29.

Redirecting a call

To redirect an incoming call to another location without answering the call

1 Pressthe Redrct softkey.
2 Usethediapad to enter the new address.

3 Pressthe Redrct softkey to add the new party.

To redirect an incoming call using the outbox or address book

Press the Redrct softkey.

Press an outbox or address book quick button.

1

2

3 Highlight the entry you wish to redirect to and press the Select softkey.
4 Pressthe Redrct softkey.

Declining a call

When you decline an incoming call it stops ringing on your telephone. The caller
receives a decline message and abusy signal. You can also decline acall and
specify areason if you have configured reject reasons through the View menu.
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To decline an incoming call without a reason

1 Pressthe Decline softkey.

2 Pressthe Ok softkey to decline the call. The calling party receives a busy
signal.

Or pressthe Cancel softkey to cancel the decline. The original ringing display
appears.
To decline an incoming call with a reason

1 Pressthe Decline softkey.
2 Pressthe Reason softkey. A selection of different text messagesis displayed.

Tip: If there are no reject reasons defined then the Reason softkey will
not appear on the display.

3 Highlight areason and press the Select softkey.

4 Pressthe Ok softkey to decline the call. The calling party receives a busy
signal and the regject reason appears on their display.

Or pressthe Cancel softkey to cancel the decline. The original ringing display
appears.

Note: For information about creating or changing a list of Reject

=»| Reasons see “Adding reject reasons’ on page 54. For information about
setting the 12004 Internet Telephone to automatically decline all calls see
“Do not Disturb (DND)” on page 66.

Ignoring a call

You can stop an incoming call from ringing (see “ Setting Ignore action” on
page 29 for an explanation of options) and have it handled by your ring list.

To ignore an incoming ringing call

1 Pressthelgnore softkey.
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2 Pressthe Ok softkey to passthe call. The cal is handled by your ring list.
When thering list is exhausted, the caller receives a busy signal.

Or pressthe Cancel softkey to cancel the ignore process. The original ringing
display appears.

Tip: For more information about creating aring list refer to the SP
Personal Agent User Guide.
s

Sending and receiving instant messages

Your 12004 Internet Telephone beeps to alert you when you receive a new instant
message (IM) and shows the message on the display.

To send an instant message press the quick button and select the

Send IM option.

Note: For more information about instant messages see “ I nstant
=»| messaging” on page 63.
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Chapter 5
Managing your calls

This section describes how to manage your calls efficiently using both the i2004
Internet Telephone quick buttons and more advanced features in the View menu.

The View menu option provides you with the following options:

Buddies
Presence

Call Subject
Reject Reasons
Line Information
Inbox

Address Book
Outbox

Tip: For quick selection, press the number on the dialpad that
corresponds to the menu item. Use the up and down navigation buttons
S to scroll through the Configuration menu list. The * button takes you to
the beginning of alist and the # button takes you to the end of alist.

00 N OO o M WN PP

Note: Some menu options allow you to configure or view parameters
that are specific to aline. If there are multiple users logged on to the
telephone then you will be prompted to select your line button.
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Some of these items can also be accessed using the quick buttons.

Address book Inbox Outbox

Accessing the list of Buddies

You can maintain alist of userson your system that you frequently contact, using
the SIP Personal Agent. Through the View menu on your i2004 Internet
Telephone you can see who in your list of Buddies is Online, Offline, Busy, Be
Right Back, Out-to-Lunch and Away.

To access the list of Buddies

1 Pressthe View softkey.

2 Highlight the Buddies option and press the Select softkey to access your list
of Buddies. Your personalized list of Buddies appears on the screen with
information about their online status.

You can use the Call softkey to call the entry you highlight.

Tip: For more information about creating a list of Buddies refer to the
SIP Personal Agent User Guide.
s

Changing your presence status

The presence option allows you to alert other users on the system to your online
status. Users that have you listed as one of their buddies can see if you are online,
offline, busy, be right back, away or out for lunch.

To change your online status or presence

1 Pressthe View softkey.
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Highlight the Presence option and press the Select softkey. Your current
presence status appears on the display and you are prompted to change it.

Press the Yes softkey. A list of presence options appear (use the navigation
buttons to scroll through the list).

Highlight a presence option and press the Select softkey. The display shows
your new presence status and prompts you to confirm.

Press the Ok softkey to confirm.

Note: If thei2004 Internet Telephone resets then your presence status

=»| defaultsto "online".

Adding call subjects

You can create a handy list of call subjectsto let the person you are calling know
the nature of your call. The subject text can be up to 100 charactersin length
however recipients may need to scroll to see long messages.

To create subjects for outgoing calls

1
2

Press the View softkey.
Highlight the Call Subject option and press the Select softkey.

(If thisisyour first call subject then you can begin to enter the text
immediately.)

Press the Add softkey.
Enter the subject text.
Press the Ok softkey.

softkey to edit thetext, or use the Dd ete softkey to remove an entry from

Tip: You can highlight an existing Subject entry and press the M odify
$

thelist.

Note: For information on how to use this feature refer to “Adding

=»| subjectsto acall” on page 38.
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Adding reject reasons

When you are unable to answer a call you can send a message telling the caller
why you cannot answer. The reject reason text can be up to 40 charactersin length
however you must scroll to see messages longer than 24 characters.

To create call reject reasons

1 Pressthe View softkey.

2 Highlight the Reject Reasons option and press the Select softkey.
3 Pressthe Add softkey and enter the desired text.

4 Pressthe Ok softkey.

Tip: You can highlight an existing regject reason entry and press the
M odify softkey to edit the text, or use the Delete softkey to remove an
J

entry from the list.

Note: For information on how to use this feature see “To decline an
nd incoming call with areason” on page 48.

Viewing line information

You can see the username, domain, presence, IM active, redial option and feature
activation information for each user logged into the telephone.

To view user information

1 Pressthe View softkey. If thereis more than one user logged in to the
telephone then you will be prompted to press the Line button for the user
information you want to query.

2 Sdect the LineInformation option and press the Select softkey. The
information corresponding to the user assigned to that line appears on the
screen.

3 Pressthe Ok softkey to return to the View menu.
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Using the inbox options

Your 2004 Internet Telephone maintains an inbox list of calls that you returned.
You can access this list through the View softkey or by pressing the inbox quick

button .
=

When your telephone isidle and you access the inbox, the following softkey
options appear:

« toggle between the inbox lists of All callsand Missed calls
e Call apreviouscaller

e Deélete the entry from the inbox

e returntotheidledisplay (Ok)

When you are on an active call and you access the inbox, the following softkey
options appear:

e Sdect tocal anentry
e Cancd to return to the active call display.

To call an inbox entry

From aidle display

1 Press.

(Use the navigation buttons to highlight a particular inbox if more than one
user islogged in, and press the Select softkey to access that inbox.)

Highlight an entry or enter the number associated with the entry.

3 Pressthe Call softkey to dial the entry and return the call.

the right of the screen. Use the left navigation button to scroll back to the

Tip: Usethe right navigation button to access the details information to
previous screen.
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To call an inbox entry while on an active call

1

e (TN

(Use the navigation buttons to highlight a particular inbox if more than one
user islogged in, and press the Select softkey to access that inbox.)

Highlight an entry or enter the number associated with the entry.

Press Select. The active call isautomatically put on hold and the new call
rings.

Saving an inbox entry to the address book

To save an entry in your inbox to your address book

1

Highlight the entry and press the right navigation button to access entry
details.

Press the Save softkey. The display prompts, “ Save as?’. You can change the
entry text. Use the left navigation button to erase the existing text if you need
to add new text.

Press the Save softkey again. The display confirms the address book update.

Note: You cannot save an inbox entry to the address book while you are

=»|  onanactivecal.

Deleting an inbox entry

To remove an entry from your inbox

1
2
3
4

= ETH

Highlight an entry or enter the number associated with the entry.
Press the Delete softkey.
To delete the single entry press Ok.

To delete al the entries from a particular caller pressthe AllUsr softkey. To
delete all of theinbox entries press the All softkey.
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Managing your address book
The i2004 Internet Telephone allows you to keep alist of addresses.

Accessing your address book

To access your address book and make a call

1 Press . (Or pressthe View softkey, highlight the address book

option and press the Select softkey.)
Use the navigation buttons to highlight an entry.
3 Pressthe Call softkey to place acall.

Adding an entry
To add an entry to the address book

1 From the address book screen, press the Add softkey.
2 Enter the address and/or number.
3 Pressthe Ok softkey.

Removing an entry
To remove an entry from the address book

1 Highlight the entry in the address book.

2 Pressthe M odify and Delete softkeys. The display changesto a confirmation
screen.

3 Pressthe Ok softkey to delete the entry or Cancel to cancel the deletion.

Editing an entry
To edit or change a address book entry

1 Highlight the entry in the address book.
2 Pressthe M odify softkey.
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3 Enter the changes. (Use the left and right navigation buttons to delete
characters within the entry.)

4  Pressthe Ok softkey to commit the changes or Cancel to cancel the changes.

Managing your outbox

The 12004 Internet Telephone keeps allist of all your outgoing calls.

Accessing your outbox

To access your outbox and make a call
1 Press . (Or press the View softkey, highlight the Outbox
option and press the Select softkey.)

2 Usethe navigation buttons to highlight an entry or enter the number
associated with the entry.

3 Pressthe Call softkey to dial the entry.

right of the screen. Use the left navigation button to scroll back to the

Tip: Usethe right navigation button to access the information to the
previous screen.

Deleting an outbox entry

To remove an entry from your outbox

1 prees (ENEETE

2 Usethe navigation buttons to highlight an entry or enter the number
associated with the entry.

Press the Delete softkey.
To delete the single entry press Ok.

To delete al the entries from a particular caller pressthe AllUsr softkey. To
delete all of the outbox entries press the All softkey.
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Saving an outbox entry to the address book

To save an entry in your outbox to your address book

1 Highlight the entry and press the right navigation button to access entry
details.

2 Pressthe Save softkey. The display prompts, “ Save as?’. You can change the
entry text.

3 Pressthe Save softkey again. The display confirms the address book update.
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Chapter 6
Advanced features and services

The Services menu gives you access to many advanced 12004 features:

Stock Query
Send IM

Call Forward
Do Not Disturb

User Login

o O~ W N P

User Logout

Tip: For quick selection, press the number on the dialpad that
corresponds to the menu item. Use the up and down navigation buttons
S to scroll through the Configuration menu list. The * button takes you to
the beginning of alist and the # button takes you to the end of alist.

Note: Some menu options allow you to configure or view parameters
that are specific to aline. If there are multiple users logged on to the
telephone then you will be prompted to select your line button.
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Stock query

Your 2004 Internet Telephone can be set up to display stock quotes on the
display.

Note: Thisfeature may not be activated for your system. Contact your

nd system administrator for more information.

To setup the stock query feature

1

Sdlect the Servcs softkey.
Highlight the Stock Query option and press the Select softkey.

Enter the symbol of the stock that you want to query. The default mode for
entering a stock symboal is alphanumeric.

Press the Submit button. The display may change briefly to show that the
query isin progress. When the query is complete, the result is displayed.

Press the Save softkey.

Press the Add softkey to add this stock query to a bulletin that displays on
your screen.You can aso query for another stock or press the Cancel softkey
to go back to the Idle screen.

Tip: For ashortcut to the stock query option press the -W
button
C

To remove a stock query entry

To remove a stock query

1

Sdlect the Servcs softkey.
Highlight the Stock Query option and press the Select softkey.

Enter the symbol of the stock that you want to delete from your Stock Query
Bulletin list. The default mode for entering a stock symbol is alphanumeric.
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4 Pressthe Submit button. The display may change briefly to show that the
guery isin progress. When the query is complete, the result is displayed.

5 Pressthe Save softkey. The display prompts you to remove the stock.
Press the Remove softkey to delete this entry.

Instant messaging

You can send a message that will appear on the telephone display of another user
on the system.

To send an instant message

Sdlect the Servcs softkey.

Highlight the Send IM option and press the Select softkey.

Enter the recipient’s alphanumeric address (for example, jdoe@domain.com).
Press the Next softkey.

Enter your message text.

o 00~ WDN B

Press the Send softkey. A confirmation message appears.

Tip: For ashortcut to the Send IM option pressthe
button.
o

Send an IM to an entry in the inbox, outbox or address book

To send an instant message to an entry in your address book or outbox

Sdlect the Servcs softkey.
Highlight the Send IM feature and press the Select softkey.
Press an I nbox, Outbox or Address Book quick button.

Highlight an entry and press the Select softkey.

a A W N B

Enter your message text.
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6

Press the Send softkey. A confirmation message appears.

Handling incoming instant messages

When your 12004 Internet Telephone beeps to aert you of anew instant message
(IM), you can

1
2

Use the navigation buttons to scroll through the IM text.
Use the Detail softkey to view details about the IM

— Press Call to call the sender of the IM.

— Pressthe Reply softkey to reply to an IM. Enter the desired message
using the alphanumeric input mode, and select the Send softkey, or
Cancel to return to the previous screen.

Use the Prev and Next softkeysif you have more than one IM to view.

Press the Cancel softkey to clear al IM messages.

Call forward

You can forward your calls to other locations with your 12004 Internet Telephone
Call Forwarding feature.

line associated with you will have call forwarding enabled.

Tip: If you are logged into multiple i2004 Internet Telephones, every
s

Forwarding a call

To forward your callsto another location

1
2

Press the Servcs softkey.

Highlight the Call Forward option and press the Select softkey. (See Note
below if there is more than one user logged in.)

Enter the destination address. Or, press an inbox, outbox or address book
quick button and select an entry from the list.
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4 Pressthe Forwrd softkey.

Once you compl ete setting up the forwarding, the display on your phone set
briefly changes to indicate that calls are now forwarded. The telephone icon next
to the line button becomes hollow.

Note: If thereis more than one user logged into the i2004 Internet
> Te ephone then you must press the line button next to the line you want to
forward. Or, press the Ok softkey to forward the primary line.

Tip: You can still place outgoing calls, even though your lineis
forwarded to another location.
s

Canceling a forwarded call

To cancel call forwarding on your line

Tip: If you are logged into multiple i2004 Internet Telephones, every
line associated with you will have call forwarding canceled.
s

1 Pressthe Servcs softkey.
2 Highlight the Call Forwarding option and press the Select softkey.

3 Pressthe Ok softkey to cancel forwarding for the primary line. If thereis
more than one user logged in then you will be prompted to pressthe line
button next to the line that you wish to cancel forwarding.

When you press the forwarded line button, call forwarding is canceled
immediately.
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Do not Disturb (DND)

The Do not Disturb feature blocks all calls on a per line basis and prevents them
from ringing on your i2004 Internet Telephone. If your 12004 Internet Telephone
isthe only device defined in your first ring list then any incoming calls will be
directly sent to the next ring list. If you have multiple contacts listed in your first
ring list then the other devices will continue to ring for the defined number of
rings before the call moves to the next ring list.

Tip: For more information about creating aring list refer to the SP
Personal Agent User Guide.
S

1 Pressthe Servcs softkey.
2 Highlight the Do Not Disturb option and press the Select softkey.
3 Pressthe Ok softkey to enable Do not Disturb. Incoming calls do not ring.

Tip: Asashortcut, pressthe DND softkey on theidle display to activate
the Do not Disturb feature.
S

User login

Tolog in as an i2004 Internet Telephone user

Press the Servcs softkey.
Highlight the User L ogin option and press the Select softkey.
Enter your user 1D and press L ogin.

Enter your password and press L ogin.

a A WO DN B

Enter an amount of time and press L ogin or, press the UseProv softkey to use
the network provisioned values.
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User logout

To log out as an i2004 Internet Telephone user

1 Pressthe Servcs softkey.

2 Highlight the User L ogout option and press the Select softkey. The screen
prompts you to indicate your line (if there is more than one user logged in)
and then for your password.

Enter your password.

Press the L ogout softkey.
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Appendix A
Using the SIP Multimedia PC Client and the i2004
Internet Telephone

You can use your 12004 Internet Telephone to provide premium-quality voice
communication while your PC, with the SIP Multimedia PC Client, provides
advanced | P and multimedia services. For more information about this SIP

Multimedia PC Client Set refer to the SP Multimedia PC Client User Guide.

To set up your SIP Multimedia PC Client to control your i2004 Internet Telephone

1 Select Tools > Preferences and the i2004 I nternet Telephone list item.The
12004 window displays.
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Figure 7 Preferences - i2004
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2 Check Usethei2004... to indicate that you want the i2004 Internet Telephone
to provide premium-quality voice while the PC provides advanced I P and
multimedia services.

3 Enter the port number (and optionally the MAC address) for the i2004
Internet Telephone.

the MAC address field with information it obtains from the first i2004
Internet Telephone that attempts to contact it on the port specified in
Step 4.

Tip: The SIP Multimedia PC Client can automatically detect and fill in
s

4 Check whether you wish the network to take over control of the 2004 Internet
Telephone when the SIP Multimedia PC Client exits.The default is that this
featureis activated. This step isoptional.
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5 Check whether the SIP Multimedia PC Client should route voice to/from the
telephone set for private | P addresses. This option may be required if you are
using aprivate LAN in ahome office.Thisis not usually required for work
office use.The default for this feature is not active. This step is optional.

6 Click Ok to save your changes or Cancel to exit without saving.

SIP Multimedia PC Client main window

The SIP Multimedia PC Client main window has a status area with an 1" button.
This button turns green when the SIP Multimedia PC Client controls the 2004 for

voice telephony.

Figure 8 SIP Multimedia PC Client main window
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Appendix B
Troubleshooting

This section includes instructions for resolving some common problems that you
may encounter.

Locating the MAC address

Examine your i2004 Internet Telephone set. A white label on the bottom of the set
shows a series of two digit numbers (similar to 00 60 38 XX XX XX) that make
up the device's MAC address. Write this sequence down for later use. The
following picture shows how to locate the MAC address:

Manually restarting your i2004 Internet Telephone

There are two ways that you can manually restart your 12004 Internet Telephone
by:

1 Power cycle (unplug and replug) your phone, or,
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2 Pressthe Config softkey and select the Reset Phone option.

Call does not connect

Before reporting a network problem ensure that you are using the correct address
to call someone.

Using SIP addresses versus IP addresses

Rather than dialing an | P address (for example, ron@12.134.47.78), remember to
use the SIP address (for example, ron@acme.com). The proxy server that routes
the call may serve multiple domains and would not know the domain where a user

|P address resides.

Domain name

You must enter the domain (for example, @acme.com) if the person you are
calling is not in your domain.

Note: The domain namein a user address may not be an Internet domain.

Call is connected but there is no audio

If you are using the handset, check to ensure that the headset button is not
activated. The bright red LED light beside the button indicates when the headset
option isactive. When the headset option is active, and even if thereis not headset
plugged in, you cannot receive or transmit audio through the handset.
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Quality of service information

In order to improve your service or perhaps, to determine a solution to a quality
issue, your service provider may ask you to record quality of service information
for your calls.

To view quality of service information for an answered call

1 Pressthe QoS softkey.
2 Notetheinformation displayed for the media stream of this call.
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Appendix C
Setting DHCP parameters

After you power up your i2004 Internet Telephone, if the display indicates that the
server is unreachable and it continuously resets then you need to configure some
parameters.

01/01 12:00 am

Server unreachable
Restarting . . .

Things to consider when setting parameters

Enter requested information in the menu fields by pressing the number keys
on the dialpad. Pressthe * key to enter a period (".") when entering an |P
address.

To record the entry and advance the initialization to the next parameter, press
Ok.

To abandon the manual configuration process and restart the power-up, press
Cancdl.

If you enter parameters manually, use the BK Space or Clear softkeys to edit
the default entry. BK Space del etes each character asthe key is pressed. Clear
deletes the entire entry.

Each parameter must have a corresponding entry. An audible beep notifies
you if you attempt to advance to the next parameter without afield entry.
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Begin the initialization process

To begin theinitialization process, at the flashing Nortel Networks screen, quickly
press each of the four softkeys (located at the bottom of the display screen) once,
pressing from left to right.

Tip: If you miss the flashing introduction screen, unplug and plug in
your i2004 Internet Telephone to reach the configuration screen where
s

you can press the softkeys.

If your network supports DHCP go to page 78. If your network does not support
DHCP go to page 80.

If your network supports DHCP

1 If your i2004 network supports DHCP, enter the configuration parameters at
the prompt in the display area of your phone as described in Table 9.

Tip: You may need to contact your system administrator to check
whether your network supports DHCP.
s
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Table 9 Setting DHCP configuration parameters

Parameter Value Definition

DHCP (enable) 1 Yes

DHCP (full or partial) 1 Partial

S1IP <valid Server IP address> Primary server (IP Client

Manager or SIP Multimedia
PC Client) IP address

S1 PORT 5000 Primary server port

S1 ACTION 1 Primary action code (must
be setto 1)

S1 RETRY Count 1 Primary retry count

S2 1P <valid Server IP address> Secondary server (IP Client

Manager or SIP Multimedia
PC Client) IP address

Note: If you do not know the
secondary IP address, use
the primary IP address for
the secondary address.

S2 Port 5000 Secondary server port

Note: If you do not know the
secondary port, use the
primary port.

S2 ACTION 1 Secondary action code
(must be set to 1)

S2 RETRY COUNT 1 Secondary retry count

VLAN (0=No, 1=Yes) 0 QoS 802.1q VLAN Tag

Service (applies to i2004
with firmware version
xxxxB30

Warning: The VLAN parameter should never be selected unless the
& underlying network switches have been configured to filter on VLAN
IDs. Otherwise, the i2004 may fail to work properly.

After pressing the Ok softkey on the last configuration parameter, you will
see amessage "L ocating Server".
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If your network does not support DHCP

If your network does not support DHCP

1 Enter a0onthediapad, toindicate that DHCP is not supported.

2 Follow the promptsto set all necessary parameters as described in Table 10.
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Table 10 Setting non-DHCP parameters

Parameter Value Definition

SETIP <valid IP address> IP address of your i2004
Internet Telephone provided
by your system
administrator

NETMSK <valid subnet mask> Subnet Mask provided by
your system administrator

DEF GW <valid Default Gateway> Default gateway IP network
address provided by your
system administrator

S1IP <valid Server IP address> Primary server (IP Client
Manager or SIP Multimedia
PC Client) IP address

S1 PORT 5000 Primary server port

S1 ACTION 1 Primary action code (enter 1
for UNIStim)

S1 RETRY Count 1 Primary retry count

S2 1P <valid Server IP address> Secondary server (IP Client

Manager or SIP Multimedia
PC Client) IP address

Note: If you do not know the
secondary IP address, use
the primary IP address for
the secondary address.

S2 Port 5000 Secondary server port

Note: If you do not know the
secondary port, use the
primary port.

S2 ACTION 1 Secondary action code
(enter 1 for UNIStim)

S2 RETRY COUNT 1 Secondary retry count

VLAN (0=No, 1=Yes) 0 QoS 802.1a VLAN Tag

Service (applies to i2004
with firmware version
XxXXxB30

Warning: The VLAN parameter should never be selected unless the
& underlying network switches have been configured to filter on VLAN
IDs. Otherwise, the i2004 may fail to work properly.
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After pressing the Ok softkey on the last configuration parameter, you will

see amessage "L ocating Server".

Where to go next

instructions in the following table.

After the i2004 Internet Telephone has successfully located the server, follow the

Table 11 Initializing options after setting parameters

If ...

Then ....

the telephone successfully connects to the
server and the display prompts you to enter
an activation key

Activate 06/06 9:31 am

Enter Activation Key
And Press Ok
>

Ok Alpha

go to “Step 1: Enter an activation key” on
page 6.

the telephone successfully connects to the
server and the idle display screen appears

Tom =
OnHook 06/06 9:31 am
Welcome
View Servcs DND Config

you are ready to use your telephone. Go
to Chapter 2, “Introducing the i2004
Internet Telephone,” on page 13.
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Appendix D
Customer support

You can order the following parts and suppl
from your authorized distributor as follows:

Table 12 Separately orderable parts

ies for your 12004 Internet Telephone

Description

Part number

Power supply - North America

A0619627

Power supply - Europe

A0619635

Power supply - Australia, New Zealand

A0647042

Power supply - Japan

A0828858

Power supply - Ireland

A0656598

Ethernet cat 5 cable (7 foot)

A0648375

Footstand assembly - (charcoal color used for
both ethergray and charcoal models)

A0891623

Handset (ethergray)

A0788874

Handset (charcoal)

A0758634

Handset cord (ethergray)

A0788682

Handset cord (charcoal)

A0720560

Headset

A0779338

Number card

P0744243

Number card lens

P0744242

For help finding an authorized distributor call 1(800) 4ANORTEL or (800) 466-7835.
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